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Starting ParTEST

User Login

» Select Start, Programs

» ParTEST

> ParTEST

» Enter your User Name and password

ParTEST Login

User Itraining Ll

FPaszward: I xxxxxxx 1 Cancel

If you still logged into ParTEST as the Administrator — Select
File, Logout. Enter your User name and password in the
ParTEST Login screen appears.

/ Each user can change their password under the Tools menu.

Passwords must be at least 2 characters and cannot contain
spaces.
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ParTEST Work Space

1€ ParTEST for Windows

Eilz Edit "WiE Tool:  Optione Help

2 go|a] = =) 6| SR [s 2|

...... nztuctions Test Contents
: tem B anks
e [E Tests

Create Mew Instruction GEHET&FE Test
Wersions
Create Mew _ Create Test
Ttem Banl Wersions for
drop-down

_ FParTEST
list / Online

L
@ ﬂ|@| @l Elifersinnﬁu j@ IE]?J
Create Test Print Helg

Print Preview

Create Mew
Obiective
] Create Mew . _
CQuestion Juick Preview
] . -
Status bar [[MC] Question 0003 Test questions: 130 | [NUM |

Located at the
bottom of the screen - the Status bar will indicate the currently
selected item and the total number of test questions in the current

test.
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Seleciion Window

2 o] = A

@@ Instructions
= (@8 Item Banks

- 8
[+ 180 Objective

[+ Econ-100
=+ Nonsense
[+ Sample

B (@@ Tests

E] Training

To display Instructions, Item Banks, and Tests select the
plus (+) sign next to the item to open the contents.

Test window

The Test window displays the list of

List of Tests

questions azzembled in a test file.

User-defined Instructions
to assembled tests

List of Ttem Banks

I f* Quick Preview window

Training : Test Contents | ltem Bank | Objective | Type
:ﬂ.] Question 0004 180 180 Objective  MC
&) Question 0005 180 180 Objective  MC
EI Question 0006 180 180 Objective  MC
EI Question 0007 180 180 Objective  MC
&) Question 0008 180 180 Objective ML
Q] Question 0003 180 180 Objective MC
&) Question 0010 180 180 Objective  MC
EI Question 0018 180 180 Objective  MC
@ Question 00719 180 180 Objective MC
Q] Question 0020 180 180 Obectve ML

Module 2 — Starting ParTEST

The Selection window displays the
three major branches of information

- Instructions
- ItemBanks/Objectives
- Questions

When vou select a question in an Item Bank the Quick
Preview window at the bottom of the screen displays

the question

[MC

L W] IPIL ] LIUESTION UL | 3
[w] C] Qv
Ll

] Question 0020

[MC] Question D021

Mhat stacte 1= Yosemite located in?

w

A,
B.
=
D.
E.

Hebraska
Tennesses
California
Texas
Arizona

Correct Answer(s): ©
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Can you match the icon with the appropriate function?

A B C D E
| @@ 2

Create New Instruction
Create Test

Create New Objective
Create New Question

Create New Item Bank

A B C
) || SR [« 2|

Print

Generate Test Versions

Print Preview
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Preferences

» Select the “Options” pull-down menu
» Select Preferences

General:
Auto prompt to select the Question Type
Auto load the last test
Show User Access Rights on Instruction, Item Bank and Test

Preferences X|

G eneral | Cluick F'reviewl Test Window | Font I:Ipticunsl

v &uto prompt to select Question Type
[T Auto load the last test

¥ Show User fizcess Rights on Instuction, ltem Bank and Test

Multiriedia File Path: |0t == I (¥ 5yt T

Quick Preview:
Select the desired options for the Quick Preview window.

Preferences

General Quick Preview | Test 'W'indcuwl Font Dptionz

V' Question V¥ Dates

¥ Comect snswer(z) I Difficulty and Dizcrimination
¥ Explanation/Fationale v ltem Analysis

¥ ReferencedM otes v Responze Frequency

¥ FKeywords

¥ Scome Details

Select&ll | Clear 41 |
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Test Window:
Select the two desired Keywords to be displayed in the Test window.

Preferences

Generall Duick Preview  Testwindow | Fant Elptiu:unsl

¥ Show Kepwords:
| 1.SysKeplabell x|

Font Options:

Select the desired fonts options for the Default Font for New Questions
and Importing a Text File, Header and Footer for Item Bank Details,
Test, and Test Details, Number and Answer Labels for Test Only.

Preferences

Generall Quick F'reviewl Test Window  Fort Options |

— Mew Question and DOS Import
Default Font Type: I Times Mew Roman j

Default Font Size: I 10 j

— Header and Foater for lbem Bank Details, Test, and Test Detailz

Font Type: ITimes Mew Roman j

Fort Size: K
— Murmber and Answer Labelz far Test Only

Fant Tupe: ITimes Mew Forman j

Font Size: I 10 j

2-8



ParTEST v6.5 Training Workbook Module 2 — Starting ParTEST

6.5.2 Add Multiple Secondary Users

This feature allows up to five secondary users to be selected for Instructions,
Item Banks and Tests. (Previous versions of ParTEST allow one secondary
user.) Secondary users have the same functionality, privileges and rights as
the previous single secondary user as described below.

To add a secondary user to a set of instructions, right click on the
Instructions and select Properties. Select the secondary user(s) to add in the
dropdown menus of the Instruction Properties dialog box. Click OK.

Secondary users can view and edit the Instructions. Please note that
secondary users cannot edit instructions after they have been used in a test.

Edit nstruction x|

Edit Tools

T est Instructior B |f | 1] |

=|a/m=| | |

Instructions:  Read each question carefilly and seZflect the correct answer,

COwner

Ovaner Mames: Iid Date Lazt Uzed: 02/05/04 1224:08

Public Read &ccess: [ Begin On New Page: [ Frotected |

Secandany Ulzers

Secandany Lzer #1: |<NDnE> j
Secondary Uzer #2: |<N0ne> j
Secondary Lser #3: |<N0ne> j
Secondary Lser #4: |<N0ne> j
Secondary Lser #5: |<N0ne> j
] | Cancel
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To add a secondary user to an item bank, right click on the Item Bank and

select Properties. Select the secondary user(s) to add in the dropdown
menus of the Item Bank Information dialog box. Click OK.

Secondary users can view the item bank, and they can add, edit, view and
delete questions in the item bank. However, after a question in the item
bank has been added to a test, you should not change the secondary users

as this will cause any tests using those questions to become invalid.

Item Bank InFormation

Harmne:

Dezcriphon:

[EREEEED 0

I.t'«l Skills

Path.

Dhaneer M ame;

Publi= Fiead access:

CAPARTESTSU0T16636%001 6720

Ovaner

id

r Lock [tem Bank: T

Secondary Users

Secordary User H1.

Secardany Lser H2
Secordan Llzer 3

Secardary User B4
secardany Llser BS

|<Nanc> LI
|<Nune> j
I-:Nonc) j
|<Nune> j
[ <

=]

Xl

Dale Craated: 07432204 10:18: 40
Dale Lazt Modifed: 09413404 Th:38: 44
Drale Last Accessed: 0372604 14:48:368
Date Last Duplicated:
Dae Last Added/Resiored
Fizlerence Number: 0516720
Total Objectives: 2
Ciky: I(Nona}- j
State: |-:Ncune> j
Caunby: I(None> j
Schoal: IcNune:> EI
Distict: | Hones =l
Teacher: I(Nc-m:}- j
Lewel |(None> j
Term: I(Nona)- ﬂ

Carcel |
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To add a secondary user to a test, right click on the Test and select

Properties. Select the secondary user(s) to add in the dropdown menus of

the Test Information dialog box. Click OK.
Secondary users can view and print a test, but they cannot add, edit or

delete it.

Test Information x|
Mame: ISE Test Sat #20 Diate Created: 07 A2 /04
- Dale Last Modified: 09/28/04
Dezcription: ||
Date Last Accessed: 03/29/04
Path;  |C:SPARTESTAWUOS1EEZENT 0516723 S5C Test Set #3 Date Last Pinted: 02/02/04
Dwner Date Last Duplicated:
Dwner Marne: Iid Date Last Added/Restared:
Secondary Users Total Questions:
Secondary Uszer #1: |<N|:|ne> j Total Versions:
> ey User 60 [<None> | | gomtomustans Tes
Secondany User #3: |<N aner ﬂ Scramble Answers: Yes
Secondary User #4: |<N anes j
Secondary Uzer #5: <N one: i
I J Set Fort for Entire Test v
Reference # |0516723 8C Test Set #30 | CAMPBELL x| e =]
Ok | Cancel |
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Instructions, Item Banks, and Objectives

Instructions, Item Banks, and Objectives are components used when
you create tests. Before you can create a test, you need to create an
Item Bank and an objective to store and retrieve the test questions.

Each Item Bank stores questions of a similar subject. Within each
Item Bank, each objective reflects or indicates the course unit that is
the focus of the questions. At least one objective must be created to
store the questions. You may create as many objectives as necessary.

Creating Instructions i

>

Y VVYVYYVY

Select File, New, Instructions or the “Create New Instruction”
icon on the toolbar

The Edit Instruction dialog displays

Enter a Name for the Instruction

Enter the Text of the Instruction

Select, if desired, Public Read Access

Select, if desired, Begin on New Page

You can create and edit instructions for students taking the test.
You can create general instructions that apply to the overall test
and/or specific instructions that apply to sections of the test.
You can create as many as you wish or none at all.

Edit Instruction x|
Edit Tools
IEhuose.-‘-‘-.nswerI Bl]l Hl%l%l%l@lﬁ“umvers j|12j

Choose the single best answer. If more than one answer is
required it will be indicated inthe question.

Date Last Uszed:
Public Fiead Access: [
Secondary Uzer: |<N|:|ne> j Begin On Mew Pags: [

(] I Cancel

Dwrer Mame: Itraining

2-13



ParTEST v6.5 Training Workbook Module 2 — Starting ParTEST

Using Instructions to control Question Scrambling

When generating more than one version (2 or more) of your test
- you can specify to Scramble answers and/or questions.

If you need to prevent a group of questions from scrambling -
you need to surround the group with instructions. Scrambling of
Questions will not occur past an instruction.

Sample Instructions:

|Eha|:uter'| l?!|HE§‘§|@{|$‘£“TimesNewHuman jl‘lE j
Chapter 1 & 2 - Administrator's Features & Difficulty / Discrimjnatiunj

|Ehapter3-5 l;f| ng§|§‘@§‘ﬁ||ﬂmesr\lewﬁuman j|12 j

Chapter 3 to §: Insttuctions, Item Banks, Ohjectives, Keywords,
Creating (Juestions, and Creating Tests.|

ParTEST : Test Contents

|‘--'|ai netiuctions
—. * Instructions “Chapter 1 & 2"

El Access Rights .
&) Creating User Accts * 0 Test Questions
i) Di Level Defaul « Instructions “Chapter 3-6”

£| Discnm Level Defaul
£| Evaluate questions

Q Secondary - discrima .
FChapter 36 ~ * The 6 Test Questions
&) Icon Tnstuiction between the two instructions

&) Icon ltem Bark will only scramble within
E] Icon Objective thei
@ [tem bank. consists €1r group
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Using an Instruction and “Keep Question Order”

You can also use an Instruction along with a group of questions

and the “Keep Question Order” selection. E.g.: If you have a
group of questions that relate back to a main paragraph - you

would enter the paragraph in an Instruction. You would use the

“Keep Question Order” for group of relating Questions.

|[)eﬁnir.glcewnld3 B |f| u E §|= |Qlﬂllﬁaf‘3‘“°”ﬂ jl” j

Feywrards ars charactenestics that descobe the questions created wnthn ttem banks, =
T ou may establish eight default keyword labels and Lsts for all itern bankes

However, pamary wsers can ceeate umgque keywords labels and ety for their own
itemn banks. The default keyword labels and bsts apphy until the indmidual user
changes them. Within sach kersrozd hets, vou can create up to 250 kevrwords. =l

Feyward : Test Contents

#| Defirong Keyweards

+ The “Instruction” is followed
by 3 questions that contain the
“Keep Question Order”.

Fepword Lists
Feyword Labels

afaul
] Evaluate questions » Those 3 Questions will
@ Secondary - discrima .
i) Expoving reports always remain below the
lpintingtest “Instruction” and will not
Q] Fepot Descrption
&) Import Fomats scramble
&] Spell Check
[K.epword Lists Blll ],l[g %I%IQlﬂllTimesNemeaﬂ 3
Wiithin each Feyword Label you can creste up to keyarords?

Asier I Score | K.eymrdl Item Anﬂ.ln'sl Fesponze Flewmdesl

Explanation/ |

R ationabe:

A (300 D [Unlimited

[ [

B: fzo0 E:

| [

. — Operatar -

C so P v

v  And Answ
O
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Item  Banks store questions of a similar subject, which are used

Module 2 — Starting ParTEST

Creating an Item Bank

more than once to create tests. You can create an unlimited number
of item banks, and a single item bank can contain up to 2,000

questions. Access to an Item Bank is also user-defined. You can
designate an Item Bank for public read access and/or secondary user

access.

» Select the “Create New Item Bank” icon on the Tool bar or

Select New Item Bank from the File pull-down menu

» Enter a name for the Item Bank
» Enter a description for the Item Bank (optional)
>

Select a Secondary User and/or Public Read Access if desired

Iterm Bank Information x|
Narme: |Language Atts S ample Date Created: 03/11/03 10:45:45
Description: ||:a|if,3mia [Jaruary 2003) D ate Last Modified: 03/11/03 10:46:23

Date Last cceszsed: 12/02/03 03:38:41
Path: IE:HF‘.&HTEST\U 78093524 74083
— D ate Last Duplicated:
Qwner Name: IIE" Date Last Added/Restored:
Secandary zer <Mones hd
Y I one J Reterance Number: FA0S34E

Public Read Access: H Lock tem Bank: [ | Total Objectives: 29

/ The “Path” displayed will be your “user” directory.

Everything you create in ParTEST will be saved to this folder.
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Creating Objectives

2

Objectives are created within an Item Bank to provide more specific
focus for a group of closely related test questions. Examples of
Objectives for the Item Bank shown below are “Admin Features” and
“Creating Questions”.

/ An Item Bank can contain up to 200 Objectives. (2,000

questions in an Item Bank within one objective or several
objectives.)

» Select the Item Bank

» Select File, New, Objective or the New Objective icon on
the Tool bar

» Enter the Name and Description.

» Select OK

L

=l [ ParTEST for Windows o
@ 01-Admin Features * Objectives are used

@ 02-Diff/Discrim to help you sort
@ 03-Instructions your Item Bank.
@ 04-ltem Bank/Objecty  + The example is

® 04Keywords sorted by the

@ 05-Creating Question )
@ 06-Creating Tests Subsll S thEi
@ 07-Printing Reports ParTEST User’s

V4] Appendix Guide

After you create Objectives, you are ready to create questions.

e I = o s = i o o = o b =
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